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Windows
Latent GOLD contains a main window called the Viewer.

Viewer. When you estimate a model, all statistical results, tables and
plots are displayed in the Viewer. In this window, you can navigate
easily to whichever section of the output you want to view. You can
also copy and paste selected portions of the output into different programs for reformatting and editing. The Viewer window opens automatically when you open the program.

Outline Pane

Contents Pane

Figure 2-1. Viewer Window
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The Viewer window contains 2 panes:

The left pane, or Outline pane, provides a hierarchical view of the contents, consisting of the names of data files
opened (the outermost level of the hierarchy), the models estimated, and output files generated for each model.
To expand/contract any level of the hierarchy, click the +/- icons. After a model has been estimated, the Outline
pane will also contain a summary measure of performance (the L2 or LL statistic) for the model to the right of the
model name.

The right pane, or Contents pane, contains text output, tables, or plots corresponding to that which is
highlighted in the left pane. Many of the tables and plots may be modified interactively using the options shown
on a Control Panel or the View Menu.

You can use the scroll bars or the up/down arrow keys to browse results, or you can click an item in the Outline
pane to view the corresponding output in the Contents pane.
To change the width of the Outline pane, click and drag the right border or select Split from the Window menu.

The Outline pane of Latent GOLD contains 4 hierarchical levels:
1.

The first (outermost) level lists the data files that have been opened.

2.

The second level lists model names for 1) models that have been estimated for the associated data
file, and 2) models that have not yet been estimated.

3.

The third level lists output files produced for each model estimated.

4.

The fourth level lists plots and other output subcategories associated with that output file.

Figure 2-2. Outline Pane levels
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For example, in Figure 2-2, the data file opened is ex1.sav (1st level), for which 4 models were estimated - named
Model1, Model2, Model3, and Model4 (2nd level). Model5 is the name assigned to a New Model that has yet to
be specified. Names associated with the 3 output files associated with Model3 appear in the Outline Pane Parameters, Profile, ProbMeans (3rd level). The Tri-Plot, associated with the ProbMeans output, is currently
highlighted (4th level). When an entry in the Outline pane is highlighted, its content is displayed in the Contents
pane (text file or plot).

After one or more models are estimated for a data file, you may specify a new model by opening the analysis dialog box associated with 1) the new model default name (created automatically at the bottom of the list of model
names), or 2) any model that has been estimated previously. For previously estimated models, you can specify
a new model by modifying the settings for this model. For new models, the default settings correspond to the last
model estimated. A detailed description of the 10 basic steps used to specify and estimate a model is given in
Chapter 5.
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Click items in the Contents pane and highlight the portion of the output in the Contents pane you want to
copy (you may click Edit, Select All to select the entire contents displayed, then click Ctrl-C or select Edit,
Copy to copy the output to the clipboard to be pasted into other programs.

Menus
The Menu Bar in Latent GOLD has 6 general menu options: File, Edit, View, Model, Window, and Help
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This file menu can be used to perform the following functions:

Open. Opens a data file. Latent GOLD accepts as input data an SPSS system file, an ASCII text
(rectangular) file, a special 'array' file format for multi-way tables. In addition, you can Open a
previously saved Latent GOLD definition (.lgf) file. For additional information on opening data files, see
Chapter 3. Upon opening a data file, the data file name is listed in the Outline Pane (outermost level)
and the default file name 'Model1' appears beneath the data file (second level), and may be used to
specify and estimate a New Model.

Close. Closes the data file highlighted in the Outline Pane.

Save Results. Allows you to save your output to either a html or an ASCII (text) file. For more information, see Chapter 3.
15

LATENT GOLD® 4.0 USER'S GUIDE
Save Definition. This saves the analysis settings that have been specified for one or more models on
a particular data file. For more information, see Chapter 3

Print. Prints output obtained after any model estimation See Chapter 4.

Print Preview. Preview printed output on screen. See Chapter 4.

Print Setup. Sets various printing options. See Chapter 4.

At the bottom of the File menu, recently opened data files are listed for easier access.

Exit. Exit the program. Prior to exiting, Latent GOLD will prompt you to save your Model definitions and
results if you have not already done so.
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Copy. Allows you to copy to the clipboard any output highlighted in the Contents Pane

Select All. Selects all output shown in the Contents Pane

Plot Font. Allows you to customize the plot font for the output plots in the Content Pane. Upon making
a change to the font, this change goes into effect the next time the plot is opened in the Contents Pane.

Text Style. Allows you to customize the text style for the output in the Contents Pane. Upon making a
change to the text style, this change goes into effect the next time the output listing is opened in the
Contents Pane.

Format. Allows you to change the format (General, Fixed and Scientific) and number of digits for
numeric values displayed in the output. For further details, see Chapter 4.
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The options available in the View Menu change depending upon what is highlighted in the Outline Pane. For
example, when a model name is highlighted, the options are:

Toolbar. Shows the shortcuts Toolbar. See Toolbar for more information
Status Bar. Shows the status bar. The status bar displays various information as the model is being
estimated. See Status Bar.
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ProbChi. Opens the ProbChi calculator. This calculator can be used to obtain a p-value for a given chisquare (or vice-versa) for a specified number of degrees of freedom, df. For more information, see
Chapter 5.

When an interactive table or plot appears in the Contents pane, the View Menu lists the various options for changing the appearance of the associated output.
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The Model Menu options are organized into 3 sections. The first section contains the options for specifying the
type of model to be estimated:

Cluster. Specifies a Cluster model to be estimated.

DFactor. Specifies a DFactor model to be estimated.

Regression. Specifies a Regression model to be estimated.

If model names appear in the Outline pane for one or more models that have already been estimated:

If you click on a model name associated with a previously estimated model, the Model Menu contains
a checkmark next to the type of model estimated.

If you click on the name for a new model (one that has not yet been estimated), there will be a checkmark next to the last type of model estimated.

Model options appearing in the second section of the Model Menu are

Estimate. Estimate the model. Select this option once your new model is fully specified (see Chapter 5)

Estimate All. This option may be used when the Outline Pane contains names for 1 or more models
associated with a data file that have not yet been estimated. Upon selecting the data file name, the
Estimate All menu entry becomes active in the Model Menu. Selection of this option causes all of the
associated models that have not yet been estimated to be estimated sequentially beginning with the first
such model.
Note: Multiple model names associated with models that have not yet been estimated can occur
for a data file only if a previously saved definition (.lgf) file containing the setup for 2 or more
models is opened. For details on saving .lgf files, see SAVE DEFINITION in the FILE menu
options.
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Bootstrap L2 and Bootstrap -2LL Diff. The Bootstrap option can be used to estimate the p-value for
certain estimated models. See Chapter 5, Step 9, for more information.

Stop. The Stop command may be used to pause the estimation prior to completion, or to abandon the
estimation completely. See Chapter 5, Step 10, for more information.

Resume. If a model is paused (default names for paused models have the characters 'Paused'
appended to the original model name -- e.g., 'Model4Paused'), the Resume command may be used to
continue the estimation process.

Delete. This is used to delete the model name (and any associated output files) from the Outline pane.
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Split - Allows you to customize the window split between the Outline and Content Panes

H

E

L

P

Contents. Lists all the Help topics available

Help. Displays context-sensitive help.

Item Help. Creates a help cursor that you can point to get help on any particular item in the program

Register. Displays your registration code.

About Latent GOLD. Provides general information about the program.

Many of the tasks you will want to perform with Latent GOLD utilize menu selections. Shortcuts for menu items
are listed to the right of the item. For example, the shortcut for File, Open is Ctrl+O (on your keyboard, hold down
the Ctrl key and then press the 'O' key).

In addition, a right click in the Contents Pane frequently causes a control panel or the appropriate menu options
to appear. For example, a right click in a graphical display (such as the tri-plot) causes the (Tri-plot) Control Panel
to appear which can be used to modify the appearance of the Plot in an interactive manner. A right click in the
Parameters Output retrieves a pop-up menu containing the Options from the View Menu which allow you to
change the appearance of the output in various ways such as adding a column for standard errors.
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Toolbar

The toolbar provides quick, easy access to common tasks. When you position the mouse pointer on a tool,
ToolTips provides a brief description.

File Open

File Print

File Save

File Print Preview

Edit Cut

Model Estimate / Resume

Edit Copy

Stop Model Estimation
Pause/Abandon/Continue

Edit Paste

Get Help using mouse cursor

To Show or Hide the Toolbar
w

From the menus choose: View g Toolbar

To Move the Toolbar
w

Click anywhere in the tool bar outside the Tool Bar buttons.

w

Drag the Toolbar to a new position.

•

Dragging the Toolbar to the left or right side of the window attaches the Toolbar vertically to that side.

•

Dragging the Toolbar to the top or bottom of the window attaches the Toolbar horizontally.

•

Dragging the Toolbar anywhere other than the window borders creates a detached, floating Toolbar.
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Status Bar

The status bar at the bottom left of the Latent GOLD application window provides:

•

Current information about a menu option that is highlighted.

•

Status of a current model estimation including number of iterations and warning messages.

•

Basic descriptive information regarding variable labels and values associated with various objects
selected on an active plot. Objects that can be selected include plot symbols, and reference lines.
Simply left click an object to select it.

To Show or Hide the Status Bar
w

From the menus choose: View g

Status Bar

Dialog Boxes
Most menu selections open dialog boxes which you will use to select variables and set analysis options. To
manually move within a dialog box from one item to another, use the tab key. Alternatively, a shortcut can be
used to reach dialog box items which contain an underlined letter as part of their descriptive name. Such items
can be reached by typing the letter in conjunction with the Alt key. For example, in the Technical Tab portion of
the Analysis Dialog Box, the shortcut to reach the Iteration box is Alt+I (on your keyboard, hold down the Alt key
and then press the 'I' key).
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After you have selected from one of the three types of models, an Analysis dialog box appears that is appropriate for that model type. This dialog box has six basic tabs (plus an optional Advanced Tab) for Cluster and
DFactor models and five basic tabs (plus an optional Advanced Tab) for Regression models. Some tabs are
common to all model types:

Variables Tab
For each of the 3 modules, the first basic tab, called the Variables Tab, has a common structure.
The Source variable list provides a listing of all variables in the working data file. By default the
variables are listed in the order they appear in the data file. To list them in alphabetical order, check the
Lexical Order box.
Target variable list(s) specify how the variables are to be treated in the analysis. For example, a variable can be specified to be used as an indicator, dependent, predictor, case weight, replication weight
or covariate, by selecting and moving it to the appropriate target list box. The target list boxes that are
available depend upon the type of model selected.
For more specific information about the options related to a type of model, see Chapter 5.
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Model Tab
The second basic tab is the Model Tab. It contains options that affect the number of model parameters
that will be estimated. For an LC Cluster or LC Regression model, this tab may be used to change the
settings for the number of classes and to impose various model restrictions such as restricting certain
effects to equal 0. For an DFactor model, this tab may be used to change the settings for the number
of DFactors and DFactor levels, restrict to zero the effects of certain indicators on selected DFactors
and to remove zero restrictions on correlations between selected DFactors.

ClassPred Tab
The third basic tab is the ClassPred Tab. It allows you to specify a Known Class Indicator, or to use the
results from an estimated model to score a data input file by appending selected prediction and/or
classification information to it.

Residuals Tab (Cluster and DFactor only)
The fourth basic tab is the Residuals Tab. This tab displays bivariate residuals (BVRs) and allows you
to specify new models containing one or more "direct effect" parameters, each generally associated with
a large BVR. A bivariate residual substantially larger than 1 indicates that the estimated model fails to
account for all of the pairwise association associated with 2 indicators, or an indicator and an (active)
covariate. See section 7.6 in the Technical Guide for further information about BVRs.

Output Tab
The next basic tab is the Output Tab. This allows you to generate selected output file listings following
the estimation of a model. For example, selection of the optional 'Standard Classification'
generates a file listing containing the modal assignment and posterior membership probabilities for each
case (or each grouped case if 2 or more cases have the same values on all observed
variables). The Output Tab also contains options for specifying the methods to be used in the
computation of standard errors (Hessian, outer-product, or robust), in the prediction of the dependent
variable (posterior mean, HB-like, or marginal mean), and in the coding of nominal variables.

Technical Tab
The last basic tab is the Technical Tab. It allows you to change the settings for various technical options
before a model is estimated. These options include algorithmic settings such as convergence limits,
iteration limits, start values, model settings such as Bayes constants, and the use of dummy coding as
opposed to effects coding of parameters, bootstrap settings, treatment of missing values, and a control
for the precision of CFactors, an optional Advanced feature.

Advanced Tab (Optional)
This tab contains several advanced features. It requires the Advanced version of Latent GOLD 4.0. The
Advanced Tab provides model options for handling complex survey data, multi-level data, and inclusions
of up to 3 continuous factors (CFactors) in a model.
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These buttons instruct the program to perform an action, such as run a procedure, display Help, or open a subdialog box to display additional options. Most dialog boxes contain several standard command pushbuttons:
Close. Close the current dialog box.
Cancel. Cancels any changes made to the dialog box settings since the last time it was opened, and
closes the dialog box. Within a session, dialog box settings persist until you cancel or change them.
Estimate. Estimates the parameters of the current model. After you select your variables and set any
analysis options, click Estimate to start the iterative estimation algorithm. This also closes the Analysis
dialog box.
Pause. Pauses the model estimation procedure and produces output file listings that should be viewed
as preliminary output.
Resume. Resumes the model estimation procedure for a paused model.
Help. Context sensitive help. This takes you to a standard Help window that contains information about
the current dialog box. You can also get help on individual dialog box controls by clicking the control
with the right mouse button.
OK. Runs the procedure. After you select your variables and set any additional specifications, click OK
to run the procedure. This also closes the dialog box.
In addition, the Variables, ClassPred Output, and Advanced Tabs of the Analysis Dialog Box contains
these additional command pushbuttons:
Scan. This option scans the data file and identifies each distinct category or value for variables specified as Indicators, Covariates, Dependent or Predictors. If this option is not selected before estimating
a model, Latent GOLD will automatically scan the data file before estimating a model.
Reset. Deselects any variables in the target variable list(s). Note that this has no effect on specifications, such as Scale Type and number of classes.
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Most procedures provide a great deal of flexibility. For simplicity in specifying models, the main dialog box
usually contains only the basic options used for typical models. Other specifications are made in subdialog
boxes.
Right-clicking on a variable also brings up additional menus which allow you to change variable properties.
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To select a single variable, highlight it on the source variable list and click the right arrow button next to the
target variable list.
•

For Cluster or DFactor models, you can also send individual variables to the Indicators box by double clicking them.

•

For LC Regression models, the first variable you double-click will be sent to the Dependent box if
that box is empty. Subsequent double clicks will send variables to the Predictors box.

You can select multiple variables simultaneously:
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•

To highlight multiple variables that are adjacent to each other on the variable list, click the first one
and then Shift-click the last one in the group.

•

To highlight multiple variables that are not all adjacent on the variable list, use the Ctrl-click method.
Click the first variable, then Ctrl-click each of the other variables you want to select.
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Ten basic steps to specify and estimate a model are described in detail in Chapter 5. In general, you can follow
these steps to estimate a model:

Load your data into Latent GOLD. You can open a previously saved SPSS system file, a rectangular ASCII text file, a special array file format or use a previously saved model definition (.lgf) file.
Select the type of model. Select one of the three analysis modules: Cluster, DFactor, Regression or
a 4th Module -- LC Choice if you have also have a license for the Latent GOLD Choice add-on program).
Select the variables for the analysis. Select and move variables into the appropriate target list boxes
and specify scale types.
Specify the number of clusters/DFactors/classes to be estimated.
Scan the data file (optional). This identifies each distinct category, value, and/or label on your data
file for each variable selected for use in the specified model and applies various consistency checks. If
you do not specifically request this, a file scan will automatically be performed by the program prior to
estimating your model.
Specify model options. Specify scale types for your variables, apply any parameter restrictions,
change any technical options, and request additional output files. After specifying your variables, by
default the program chooses the options for you.
Estimate the model and view the results interactively. Results are displayed in textural and
graphical form in the Viewer window. Options are available to customize the output in various ways.
Again, detailed information on these steps is presented in Chapter 5.

Getting Help
Online Help is provided in several ways:

Help Menu. Every window has a Help menu on the menu bar. Topics provides access to the Contents,
Index and Find tabs, which you can use to find specific help topics.

Dialog box help. Press the F1 key for help with the current dialog box.
Toolbar Help option. Click on the toolbar symbol
help on.

and then click on what you would like
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